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Chapter 868

Multiple Regression
using Effect Size
Introduction
This procedure computes power and sample size for a multiple regression analysis in which the relationship
between a dependent variable Y and a set independent variables X1, X2, …, Xk is to be studied. In multiple
regression, interest usually focuses on the regression coefficients. However, since the X’s are usually not
available during the planning phase, little is known about these coefficients until after the analysis is run. Hence,
this procedure uses the squared multiple correlation coefficient, R2, as the measure upon which the power analysis
and sample size is based. Gatsonis and Sampson (1989) present power analysis results for two approaches:
unconditional and conditional. Both of these approaches are available in this procedure.
Cohen (1988) defined an effect size f 2 that is calculated from the R2 or ρ2 using the relationship
𝑅𝑅 2
1 − 𝑅𝑅 2
This procedure uses the effect size directly rather than R2 or ρ2.
𝑓𝑓 2 =

Unconditional (Random X’s) Model
In the unconditional or random X’s model, the X’s and Y have a joint multivariate normal distribution with a
specified mean vector and covariance matrix given by
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The study-specific values of X are unknown at the design phase, so the sample size determination is based on a
single, effect-size parameter which represents the expected variations in the X’s, their interrelationships, and their
relationship with Y. This effect-size parameter is the squared multiple correlation coefficient which is defined in
terms of the covariance matrix as
2
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If this coefficient is zero, the variables X provide no information about the linear prediction of Y. Note that we
2
.
will use ρ2 to represent 𝜌𝜌𝑌𝑌𝑌𝑌

The sample statistic corresponding to this parameter is R2, the coefficient of determination. Often, the primary
hypothesis involves testing the significance of a subset of X’s that have been statistically adjusted for a second set
of X’s. The population parameter is then called the squared multiple partial correlation coefficient, which is
interpreted similarly.
This approach is more common because usually the independent variables are random variables that are observed
during the study. If the study were conducted twice, the two set of X’s would be different.
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Test Statistic in the Unconditional Model
An F-test with k and N-k-1 degrees of freedom can be constructed that will test whether all the regression
coefficients simultaneously zero as follows
𝐹𝐹𝑘𝑘,𝑁𝑁−𝑘𝑘−1 =

(𝑁𝑁 − 𝑘𝑘 − 1) 2
𝑅𝑅 2 /𝑘𝑘
=
𝑓𝑓
2
(1 − 𝑅𝑅 )/(𝑁𝑁 − 𝑘𝑘 − 1)
𝑘𝑘

Suppose the independent variables are divided into two sets: C containing kC variables and T containing the
remaining kT = k – kC variables. That is, we partition X = XT|XC. It can be shown that an F-test that tests the
significance of the T variables adjusted for the C variables is
𝐹𝐹𝑘𝑘𝑇𝑇 ,𝑁𝑁−𝑘𝑘−1 =

2
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2
The quantity 𝑅𝑅𝑌𝑌𝑋𝑋
is the sample estimate of the population squared multiple partial correlation coefficient
𝑇𝑇 |𝑋𝑋𝐶𝐶
2
𝜌𝜌𝑌𝑌𝑋𝑋𝑇𝑇 |𝑋𝑋𝐶𝐶 .

2
can be calculated from the R2 of fitting all the variables and the R2 of fitting
Cohen (1988) shows that 𝑅𝑅𝑌𝑌𝑋𝑋
𝑇𝑇 |𝑋𝑋𝐶𝐶
just the set C variables as follows
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Calculating the Power in the Unconditional Model
In the unconditional model approach, the statistical hypotheses that is usually of most interest is the set H0 : 𝜌𝜌2 ≤
𝜌𝜌02 versus H1 : 𝜌𝜌2 > 𝜌𝜌02 because you want to establish a lower bound for the value, not just established that it is
greater than zero.
However, the hypothesis H0 : 𝜌𝜌2 ≥ 𝜌𝜌02 versus H1 : 𝜌𝜌2 < 𝜌𝜌02 is also valid. In the program, when 𝜌𝜌12 > 𝜌𝜌02 the
former hypothesis set is assumed. Otherwise, the later set is assumed.
The calculation of the power of a particular test proceeds as follows:
𝑓𝑓2

1. Set 𝜌𝜌02 = 0 and 𝜌𝜌12 =
.
1+𝑓𝑓2

2. Determine the critical value rα from the CDF such that P(𝑅𝑅 2 ≤ 𝑟𝑟𝛼𝛼 |𝑁𝑁, 𝑘𝑘, 𝜌𝜌02 ) = 1 − 𝛼𝛼. Note that we use
the value of ρ2 specified in the null hypothesis.

3. Compute the power using Power = 1 − P(𝑅𝑅 2 ≤ 𝑟𝑟𝛼𝛼 |𝑁𝑁, 𝑘𝑘, 𝜌𝜌12 ).

Krishnamoorthy and Xia (2003) give the CDF of R2 as
2
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This formulation does not admit ρ2 = 0, so when this occurs, the program inserts ρ2 = 0.000000000001.
Finally, when computing the squared multiple partial correlation coefficient, Gatsonis and Sampson (1989)
indicate you simply need to replace N with N – kC in the above CDF.
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Conditional (Fixed X’s) Model
In this approach, the values of the X’s are preset by the researchers and are assumed to be known at the planning
stage. Since they are known constants, they are not treated as random variables with a probability distribution.
Any hypotheses that are tested are conditional on the specific set of X values. The focus in this analysis is how
much R2 increases when a certain set of independent variables is added to the regression model.
We will adopt the following notation: suppose C (controlled) and T (tested) are two, non-overlapping subsets of
2
2
= 𝑅𝑅𝑇𝑇𝑇𝑇
− 𝑅𝑅𝐶𝐶2 to be the R2 added when Y is regressed on the variables in set T after adjusting for
X’s. Define 𝑅𝑅𝑇𝑇|𝐶𝐶
2
the variables in set C. Here, 𝑅𝑅𝐶𝐶2 is the R2 when Y is regressed on only those variables in set C and 𝑅𝑅𝑇𝑇𝑇𝑇
is the R2
when Y is regressed on the variables in both sets.

Test Statistic in the Conditional Model
You can construct F-tests that will test whether the regression coefficients corresponding to certain sets of X’s are
simultaneously zero while controlling for other variables. For example, to test the significance of the X’s in set T
while removing the influence of the X’s in set C from experimental error, you would use
𝐹𝐹𝑘𝑘𝑇𝑇 ,𝑁𝑁−𝑘𝑘𝐶𝐶 −𝑘𝑘𝑇𝑇−1 =

2
�𝑅𝑅𝑇𝑇|𝐶𝐶
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2
�1 − 𝑅𝑅𝐶𝐶2 −𝑅𝑅𝑇𝑇|𝐶𝐶
�/𝑘𝑘𝐶𝐶

where kT is the number of variables in T and kC is the number of variables in C. Most significance tests in
regression analysis, correlation analysis, analysis of variance, and analysis of covariance may be constructed
using these F-ratios.
Calculating the Power in the Conditional Model
In this case, power calculations are based on the noncentral-F distribution. The calculation of the power of a
particular test proceeds as follows:
1. Determine the critical value 𝐹𝐹𝑇𝑇,𝑁𝑁−𝑘𝑘𝑇𝑇 −𝑘𝑘𝐶𝐶−1,𝛼𝛼 where α is the probability of a type-I error.
2. Calculate the noncentrality parameter λ using the formula:
𝜆𝜆 = 𝑁𝑁𝑓𝑓 2

3. Compute the power as the probability of being greater than Fu,v,α in a noncentral-F distribution with
noncentrality parameter 𝜆𝜆.

Note that the formula for 𝜆𝜆 is different from that used in PASS 6.0. The algorithm used in PASS 6.0 was based on
formula (9.3.1) in Cohen (1988) which gives approximate answers. This version of PASS using an algorithm that
gives exact answers.

Effect Size
The above formula includes Cohen’s (1988) measure of the effect size in multiple regression, f 2 .
𝑓𝑓 2 = �

2
𝑅𝑅𝑇𝑇|𝐶𝐶

2
1 − 𝑅𝑅𝐶𝐶2 −𝑅𝑅𝑇𝑇|𝐶𝐶

�

Cohen (1988) defined values near 0.02 as small, near 0.15 as medium, and above 0.35 as large.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Power, Sample Size, Alpha, and Effect Size (f2). Under most situations, you will select either Power or
Sample Size.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power of an experiment.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error (alpha). A type-I error occurs when
you reject the null hypothesis when in fact it is true.
Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means
that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that
represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
This option specifies the value(s) for N, the sample size. Note that this value must be at least one greater than the
total number of variables specified in sets C and T.
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Effect Size
Regression Model Type
Choose between two approaches to the modelling and analysis of multiple regression data. Both approaches result
in the same F-test for significance testing. However, they differ in the calculation of power.
•

Unconditional (Random X's)
This approach is by far the most realistic. It assumes that Y and the X's follow a multivariate normal
distribution. Thus, the values of the X's are not known until they are observed during the study. They certainly
are not known during the study planning phase.
Power and sample size calculation is based on the distribution of the squared multivariate (partial) correlation
coefficient. The extra variation that occurs because the X's are random variables is accounted for in the
calculation.

•

Conditional (Fixed X's)
This approach assumes that the values of the X's are known at the planning phase, usually because they are set
by the researchers. This seldom happens in practice, so this approach is usually unjustifiable.
Power and sample size calculation is based on the noncentral-F distribution. It assumes that the X's values are
preset by the experimenter.

C: Independent Variables (X’s) Controlled
These options refer to the independent variables that are controlled for.
kc (Number of X’s Controlled)
This option specifies the number of variables in set C, variables that are controlled for (or partialled out). This
number must be greater than or equal to zero. Note that kc + kT < N - 1.

T: Independent Variables (X’s) Tested
These options refer to the independent variables that are being tested for statistical significance.
kT (Number of Independent Variables Tested)
This option specifies the number of X’s in the set T, variables that are tested. This number must be greater than or
equal to one. Note that kc + kT < N - 1.
f2
Enter one or more values of the effect size parameter f 2. The value must be greater than zero. Cohen (1988)
defined values near 0.02 as small, near 0.15 as medium, and above 0.35 as large.
You can enter a single value such as 0.15 or a series of values such as 0.02 0.15 0.35 or 0.05 to 0.35 by 0.05.
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Example 1 – Finding Sample Size in the Conditional Model
Suppose researchers are planning a multiple regression study to look at the impact of a fifth independent variable
on the overall F test. They want to determine the sample size requirements needed to detect a small, medium, or
large effect. They want to consider power values of either 0.8 or 0.9 and a significance level is 0.05. They know
the X’s in advance so they want to use the conditional model for power calculations.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Multiple Regression using Effect Size procedure window. You may then make the appropriate
entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.8 0.9
Alpha ....................................................... 0.05
Regression Model Type .......................... Conditional (Fixed X’s)
kc ............................................................ 4
kT ............................................................. 1
f 2 ............................................................. 0.02 0.15 0.35

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
Model: Conditional (Fixed X's)

Power
0.8006
0.8039
0.8012
0.9004
0.9034
0.9058

N
395
55
25
528
73
33

Independent
Variables
Controlled
kc
4
4
4
4
4
4

Independent
Variables
Tested
kт
1
1
1
1
1
1

Effect
Size
f²
0.020
0.150
0.350
0.020
0.150
0.350

Alpha
0.050
0.050
0.050
0.050
0.050
0.050

Beta
0.1994
0.1961
0.1988
0.0996
0.0966
0.0942

References
Cohen, Jacob. 1988. Statistical Power Analysis for the Behavioral Sciences, Lawrence Erlbaum Associates,
Hillsdale, New Jersey.
Gatsonis, C. and Sampson, A.R. 1989. 'Multiple Correlation: Exact Power and Sample Size Calculations.'
Psychological Bulletin, Vol. 106, No. 3, Pages 516-524.
Report Definitions
Power is the probability of rejecting a false null hypothesis.
N is the number of observations on which the multiple regression is computed.
kc is the number of independent variables controlled.
kт is the number of independent variables tested.
Ind. Variables Controlled are those variables whose influence is removed from experimental error.
Ind. Variables Tested are those variables whose regression coefficients are tested against zero.
f² is the effect size. It is calculated using [R²(T|C) /{1 - R²(C) - R²(T|C)}].
R²(C) is the R² value of only the control variables.
R²(T|C) is the amount added to the overall R² value by the treatment variables after the control variables.
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Cohen's f² interpretation: 0.02 = small, 0.15 = medium, 0.35 = large.
Alpha is the probability of rejecting a true null hypothesis. It should be small.
Beta is the probability of accepting a false null hypothesis. It should be small.
Summary Statements
A sample size of 395 achieves 80% power to detect an f² of 0.020 attributable to 1 independent
variable(s) using an F-Test with a significance level (alpha) of 0.050. The variables tested
are adjusted for an additional 4 independent variable(s). The calculations
assume a conditional (fixed X's) model.

This report shows the necessary sample sizes. The definitions of each of the columns is given in the Report
Definitions section.

Plots Section

These plots show the relationship between sample size, effect size, and power.

868-7
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Multiple Regression using Effect Size

Example 2 – Validation
We will use an example from the Multiple Regression procedure to validate this procedure. Example 5 of that
procedure calculates a power of 0.9683 when alpha = 0.05, N = 15, kT = 2, and R2 = 0.6. To use this procedure, we
must translate the R2 value to an f 2 value. Using the relationship
𝑓𝑓 2 = �

we find

2
𝑅𝑅𝑇𝑇|𝐶𝐶

2
1 − 𝑅𝑅𝐶𝐶2 −𝑅𝑅𝑇𝑇|𝐶𝐶

�

0.6
� = 1.5
𝑓𝑓 2 = �
1 − 0.0 − 0.6

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Multiple Regression using Effect Size procedure window. You may then make the appropriate
entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
N ............................................................. 15
Regression Model Type .......................... Conditional (Fixed X’s)
kc ............................................................ 0
kT ............................................................. 2
f 2 ............................................................. 1.5

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results

Power
0.9683

N
15

Independent
Variables
Controlled
kc
0

Independent
Variables
Tested
kт
2

Effect
Size
f²
1.500

Alpha
0.050

Beta
0.0317

The power of 0.9683 matches the result in the other procedure.
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